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Check Your School Mail From Home: By Carole Colburn 
 

Many of you have asked about being able to check your school e-mail 
from home. I am happy to announce that it is now possible for you to access 
your Outlook account from any computer with Internet Explorer and an Internet 
connection! You will be able to check your school e-mail, as well as your 
calendar and tasks if you have a computer with Internet connection and you are 
using Internet Explorer as the browser. This will not work with Netscape as the 
browser.  You will find the web version of Outlook to be a little bit more “clunky” 
than what you see when you access your account on the network at school. 
However, you can pretty much do all the same things you do from school. You 
will be able to send messages, reply to and forward messages and even 
organize messages. You can access your calendar and create new 
appointments, send meeting requests and even check on attendee availability. 
Here is how it works. 
 

In the address field of Internet Explorer, type the following URL: 
mail.howellschools.com/exchange/logon. asp. and press the Enter Key on 
your keyboard. You will not need to type a www or http://. Your screen should 
look like this: 
 



 
 

In the Log On field, type the same username that you use when you log 
onto the network here at school. That should be the first seven letters of your 
last name and the first letter of your first name. Example: colburnc 
Press the Enter Key on your keyboard. When you do, the following box will pop 
up on your screen: 
 

 
 



If you are from an “on-campus” school (HHS, MMS, HWMS, CH VO), 
in the User Name field, simply type the same name you type for logging onto 
the network at school. This would be same name you just typed to get to this 
box. (Example: colburnc) Then, you type the same password you use when you 
log onto the network here at school.  
 

If you are from an “off-campus” school (NW, SE, SW, LR,), you must 
type the domain first, then a forward slash and your user name in the User 
Name field. (Example: Latson/smithr) and then type your password. Once you 
type this information these two fields, press the Enter Key on your keyboard. 
Web Access Outlook will default to your Inbox.  
 

 
 

You can switch to your Calendar, Contacts, or view the Public Folders by 
clicking on the shortcut icons in the Outlook Bar on the left side of the screen. 
You can view the rest of your folders by clicking on the little yellow folder icon 
just above the bolded word Inbox to the right of the Outlook Bar. This will allow 
you to see your Drafts, Outbox, Deleted Items and Sent Items Folders.  
 



 
 

You can scroll through your Inbox items by clicking the bolded black 
arrows to the left and the right of the word Page, located above the message 
pane. If you want to organize your messages, click the drop down arrow next to 
the Organize field and select the method for organizing you wish to use. 
 

 
 



Web Access Outlook is available to anyone who has an e-mail account 
currently set up through Howell Public Schools.  
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FYI: HPS is now using WebSense for Internet filtering. If you are blocked 
form a site that you believe to be an acceptable site to go to 
(www.msnbc.com, www.cnn.com, etc.) please e-mail Kim Blair at 
blairk@howellschools.com and let her know. On the other hand, if you 
should run across a site that you believe should be blocked for 
inappropriate material and it was not blocked; please let Kim know this site 
as well.  

FYI: When closing out of Class XP it is important to close by clicking the 
File menu and then scrolling down to Quit. It appears that for some 
unknown reason, occasionally, when someone has closed the program by 
clicking the X in the upper right hand corner (as you can do in most 
applications) the server may not read this as being closed. This only 
happens occasionally, but when it does, it can cause major problems when 
we are trying to do updates, etc. since the server thinks the person is still 
logged into Class XP. So, we are asking you to not close out of Class XP 
using the “X” method. Instead, please close by going to File and then down 
to Quit. This only happens with Class XP; not in any other programs.  
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Lesson Plan of the Month 

The following lesson plan comes from: 
http://www.microsoft.com/education/default.asp?ID=gengap 

Bridging the Generation Gap 
 

Grade Level: High School 
Curriculum Connections: Subjects: Sociology, Language Arts 
Required Software: Microsoft® Excel, Microsoft® Word, Microsoft® PowerPoint®  
 
What's in this Lesson:  

http://www.msnbc.com/
http://www.cnn.com/
mailto:blairk@howellschools.com
http://www.microsoft.com/education/default.asp?ID=gengap


• Teacher Guide (including How to Begin)  
• Student Activity, Step-by-Step:  

Step A: Creating a Hypothesis  
Step B: Creating the Survey  
Step C: Administering the Survey  
Step D: Analyzing the Results  
Step E: Presenting the Results  

 

Teacher Guide 
 

 

Summary:  

Students get a real life lesson in Sociology as they create a hypothesis about the attitudinal 
differences between generations, test their hypothesis with a survey, chart their findings, and 
present their answers to the class.  

Objectives:  

To introduce students to the process of creating a hypothesis and testing its validity, familiarize 
students with spreadsheet fundamentals, and encourage thoughtful discussion about 
generational differences.  

Prerequisite Skills:  

Knows the basics of Microsoft Word, how to create a basic Microsoft PowerPoint presentation 
including inserting clip art, and how to create a Microsoft Excel worksheet including sorting 
and filtering data.  

Time Allotted:  

Approximately four weeks  

How to Begin:  

Explain to students that in this lesson they are going to explore the differences between 
generations. Ask students: Is your attitude about issues in life such as politics and family values 
the same as somebody who is, say, age 50? Do older people and younger people think alike? 
On what subjects might they feel differently? Is there really such a thing as a "Generation 
Gap?" Tell students that they are going to find out for themselves. After developing a 
hypothesis that they believe reflects the differences between generations, students will design 



and administer a survey to test their hypothesis, and then chart their findings and present the 
results to their classmates.  

Adaptability 

For more advanced students, have them design the survey form in Microsoft Excel or Word. 
They'll work with the Forms toolbar to add form buttons and boxes. For help designing a form 
in Microsoft Excel, click the Office Assistant and type, "Create a form" in the search field.  
 
 

Student Activity  
 

 
 
Description: In this activity, you will write and administer a questionnaire that compares 
attitudes and opinions about certain issues, based on different variables, such as age, gender, or 
geographic region. You will then analyze your results using Microsoft Excel and report your 
findings using PowerPoint.  
 
Step A  
Creating a Hypothesis  
Software: None 
WHAT TO DO: Decide how you think generations may differ in their opinion on a particular 
topic. Team up with a classmate and choose two topics to study. These will be called 
Dependent Variables because you are stating that you believe that a person's belief about these 
topics depends on their age. The Independent Variable is what causes the differences in the 
dependent variables. In this case, the independent variable is the generation to which the person 
belongs.  
 
Choices for topics might include: politics; TV violence; movies; religion; technology; women 
in the military; gun control; family values; friendship; and eating habits.  
 
Now, decide exactly how you think the dependent variables will differ for the generations. This 
is your hypothesis. For example, if the topic is "TV violence," the hypothesis might be: 
Younger people think TV violence is fun and harmless, but older people think it is dangerous 
and harmful. Or if the topic is "women in the military, the hypothesis might be:" The older a 
person is the more he or she will believe that women in the military should not be allowed in 
combat. Or if the topic is "friendship:" Young people tend to value friends more than family, 
but older people tend to value family more than friends.  
 
Step B  
Creating the Survey  
Software: Microsoft Word 
WHAT TO DO: Use Word to create a survey form similar to the one at the end of this activity. 
With your partner, create five statements for survey participants to respond to that will 



accurately test your hypothesis. Statements should be designed to elicit answers like "strongly 
agree" or "strongly disagree."  
 
Next, assign numerical values for different attitudes toward your statements. For example:  

5 Strongly agree 
4 Agree 
3 Neutral 
2 Disagree 
1 Strongly disagree 

Present your survey statements to the rest of the class and see if the class can guess your 
hypothesis and if the statements accurately reflect the hypothesis.  
 
Step C  
Administering the Survey  
Software: None 
WHAT TO DO: Decide on a minimum number of people to be surveyed. Set up tables in 
public places, such as at a mall, inside or outside a grocery store, or at a movie theater. Please 
note: You must have the permission of your parents and the survey site owner before 
administering their survey. Be sure respondents fill out the entire survey and thank them for 
taking the time to do so. Now, for each respondent, average the numerical values of their 
responses to the survey statements and write this "score" in the Key Code Average box on the 
survey form.  
 
Step D  
Analyzing the Results  
Software: Microsoft Excel 
WHAT TO DO: You are now ready to analyze your survey data. First, clarify your variables. 
For example, independent variable: Generation; dependent variable: Political Beliefs. There 
should be one column for each dependent variable on your worksheet. When entering data into 
your worksheet, each response (completed survey) should be put in its own row and the 
Independent Variable should go in the first column. Even if you do not include this information 
in your analysis, you should at least note how many males/females there are and what part of 
the world the respondents were born in. These differences may affect your results, and are 
therefore important to record. Make these the second and third columns.  
 



 
Generation Gap worksheet created in Microsoft Excel  
 
Next, sort the data based on the generation group. Then, calculate the average score for each 
dependent variable for each group. Using Microsoft Excel's filtering features, evaluate the data 
by showing records that match certain rules, or criteria. For example, show all records of people 
who were born between 1946-1955 from the United States that scored the highest for one of 
your dependent variables.  
 
Finally, create charts that show some trend in your data.  
 
Step E  
Presenting the Results  
Software: Microsoft Excel, Microsoft PowerPoint 
WHAT TO DO: Have each team present their hypothesis and their findings to the class. 
Teams may present their ideas on the computer using Microsoft Excel to show their graphs. Or, 
each team can create a presentation in PowerPoint to demonstrate with graphics, art, 
animations, and graphs the hypothesis and the various findings.  

  

***If you have a technology-rich lesson that you would like to share with others, 
please send it to colburnc@howellschools.com no later than the last Monday 
of the month.  

mailto:colburnc@hps.k12.mi.us
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 Carole’s Training Corner  
Are you happy to have grades submitted and that task (for this quarter anyway) behind you? 
Hopefully, with continued training and help in this area, you are getting more and more 
comfortable with this process.  

How about those laptops? Are you enjoying them? Again, hopefully, with the training sessions 
offered at each school for help with laptop questions, you are beginning to enjoy the benefits of 
having a laptop computer available to you. I still have to set those sessions up at just a couple of 
schools, but at this point I have helped people at the high school, both middle schools and three 
of the six elementary schools. If I have not been to your school, check the training calendar on my 
web page for upcoming dates.  

Also, look for dates for help with getting an account set up for using the ITTI program. This is the 
Information Teacher Technology Initiative that all employees and students of a public education 
institution in the state of Michigan have access to for free on-line training. More information on 
this terrific program can be found at www.mivu.org. I will be setting up dates at each school to 
help those of you who have not yet created an account for using these NETg courses.  

The next big push, if you will, will be for ABACUS training. ABACUS is the curriculum 
management component to SASI and will allow you to access the HPS District curriculum that is 
correlated to state standards and benchmarks. Look for training dates on the calendar page of my 
web site. 

To see the complete list of class offerings for the month, check out the calendar page at 
http://hps.k12.mi.us/training/TrainingCalendarPage.htm   
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http://www.mivu.org/
http://hps.k12.mi.us/training/TrainingCalendarPage.htm


Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ 
You can have these tips e-mailed to you directly each day by signing up at the 
above mentioned site. 

********************************************************************** 
CONTROLLING DISPLAY OF THE SCROLL BARS 
At the bottom and right side of the document there are scroll bars that 
control  
what part of the document you are viewing at any given time. If you 
need more room  
to view a document, or if you are using Word without a mouse, you can 
turn them off.  
To control display of the scroll bars, follow these steps: 
 
   1. Choose Options from the Tools menu. You should see the Options 
dialog box. 
   2. Make sure the View tab is selected. 
   3. Click on either of the scroll bar check boxes. One controls the 
horizontal  
      scroll bar, the other controls the vertical. If there is an X in 
the box,  
      then the corresponding scroll bar will be displayed; no X means 
it will not. 
   4. Click on OK. 
 
With the scroll bars turned off, you must use the cursor control keys 
to move  
through the document. 
 
 
********************************************************************** 
 OPENING MULTIPLE DOCUMENTS AT ONCE 
 
Word provides a complete file management system as part of Word. One of 
the  
features of this system is that you can quickly load multiple documents 
in  
one easy step. To do this, follow these steps: 
 
   1. Click on the Open tool on the toolbar, or choose Open from the 
      File menu. This displays the Open dialog box. 
   2. Instead of double-clicking on a file name start to create a 
"selection set."  
      If you are selecting sequential files, click on the first file in 
the sequence,  
      then hold the Shift key as you click on the last. You can add 
additional files  
      to those selected by holding down the Ctrl key while clicking 
with the 
      mouse. 
   3. To remove files from the selection set, hold down the Ctrl key 
while clicking  

http://wordtipsgold@vitalnews.com/


      on a file name you previously added to the set. 
   4. When you are satisfied with the list, click on Open. 
 
  
  
********************************************************************** 
REMOVING HIDDEN PERSONAL INFORMATION FROM A DOCUMENT 
------------------------------ 
In the past, Microsoft has come under fire because Word maintains quite 
a bit  
of identifiable information with each document. This information is not 
normally  
visible, but with a little bit of sleuthing, someone could locate the 
information.  
For example, the name of a document's original author is saved with the 
document,  
but is hidden. The problem is that you may not want this information 
disclosed. 
 
With the release of Word 2002, Microsoft finally provided a way for 
you to stop personal information from being saved with a file. To make 
sure personal information is not saved with a document, follow these 
steps: 
 
   1. Choose Options from the Tools menu. Word displays the Options 
      dialog box. 
   2. Make sure the Security tab is displayed. 
   3. Select the Remove Personal Information From This File On Save 
      check box. 
   4. Click on OK. 
 
********************************************************************** 
FORMATTING THE BORDER OF A LEGEND 
 
When you create a chart in Excel, the Wizard that you follow may create 
a chart  
legend, depending on the type of chart you are using. Normally, the 
appearance of  
the legend will be acceptable for the type of chart you are creating. 
You have  
complete control, however, over how the legend appears. One of the 
elements you can  
change is the type of border Excel places around the legend. To change 
the appearance  
of the legend's border, follow these steps: 
 
   1. Click once on the legend to select it. Handles should appear 
      around the perimeter of the legend. 
   2. Choose Selected Legend from the Format menu. Excel displays the 
      Format Legend dialog box. 
   3. Make sure the Patterns tab is selected. 
   4. Use the Style drop-down list to select a different border style 
      for the legend. 
   5. Use the Color drop-down list to change the color of the border. 
   6. Use the Weight drop-down list to specify how heavy the border 
      should appear. 



   7. Use the Shadow check box to control if Excel adds a drop-shadow 
      to the legend. 
   8. Click on OK. 
 
********************************************************************** 
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Useful Links For You to Try… 

http://tft.merit.edu 

http://amigoingdown.com 

 http://www.bluewebn.com/ 

 http://www.kathyschrock.com/ 

 http://webclipart.miningco.com/mlibrary.htm 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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http://www.hps.k12.mi.us/Curriculum1.html
http://glen.cc/mtip/
http://www.remc7.k12.mi.us/oaisd/miclimb/
http://www.cyberlearning.org/
http://www.brainbuzz.com/topsites/Default.asp?CatID=1
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